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Selecting a Keyboard Layout
To select a keyboard layout, choose it from the Keyboard menu by using the mouse 
or a keyboard command, or use a hot key combination. Notice that the title bar or 
the icon of 3-D Keyboard changes when you select a different keyboard layout.

Menu:
Switch to the 3-D Keyboard window. Choose the desired layout from the 
Keyboard menu. Then switch back to your application window and return to your 
work.

Hot Key:
Without leaving your application, press the hot key combination. Hot key 
combinations are shown on the Keyboard menu next to the layout names. If no 
hot key is shown for a given layout, use the "Hot keys..." command on the 
Options menu to select a mnemonic combination. See Customizing the Hot Keys 
for details.

Whenever you type a key combination such as Ctrl+A, remember that the letter 
(e.g., A in Ctrl+A) refers to the one that is printed on the key cap of your physical 
keyboard, not the one that may be assigned to the key in a particular keyboard 
layout. For example, the French keyboard layout has A in the second row while the 
physical keyboard made for the U.S. market has A in the third row. To use the 
command Ctrl+A, press the leftmost key in the third row while holding down Ctrl, 
regardless of whether you are typing with the U.S. or the French keyboard layout.

When you temporarily leave Windows to work with a DOS program, or when you exit
Windows, the standard U.S. keyboard layout takes effect, and the additional layouts 
cannot be used.



Typing Letters with Diacritics
Most letters with diacritics are typed using the dead key method, though some are 
assigned to regular keys. In the 3-D Keyboard window, dead keys are marked by 
diacritics in an outline font.

Press a dead key. If the 3-D Keyboard window is visible, note the changed letters on 
the key caps. Only those keys that can now type a letter with a diacritic are marked.
The available dead keys are also marked. If the 3-D Keyboard window is minimized, 
pressing a dead key changes the appearance of the 3-D Keyboard icon.

Press any letter key to type a letter with a diacritic. Use the Shift keys as you 
normally do when typing upper case letters. Press the space bar to type the diacritic
by itself. Press another dead key (if available) to see letters with other diacritics. 
Press any other key to return the keyboard to its normal state.



Typing Diacritics by Themselves
Diacritics are typed using the dead key method. In the 3-D Keyboard window, dead 
keys are marked by diacritics in an outline font.

Press a dead key. If the 3-D Keyboard window is visible, note the changed letters on 
the key caps. Only those keys that can now type a letter with a diacritic are marked.
The available dead keys are also marked. A diacritic is shown on the space bar. If 
the 3-D Keyboard window is minimized, pressing a dead key changes the 
appearance of the 3-D Keyboard icon.

Press the space bar to type the diacritic by itself.



Typing the Third Symbol Assigned to Some Keys
Most keyboard layouts have keys that can produce three symbols, typed by:

- the key alone
- the key with Shift held down
- the key with the "Third symbol" key held down (explained below)

The first two symbols are typically lower and upper case letters, or a digit and a 
punctuation mark, etc. The third symbol, if available, is shown in the bottom right 
corner of the key cap in the 3-D Keyboard window. It is usually displayed in a color 
that is not used for any other purpose.

The Third symbol key is marked by a rectangle of the same color as all third 
symbols on the key caps.

If you have an IBM XT or AT style keyboard, the Third symbol key will be Alt; if you 
have an enhanced keyboard, the Third symbol key may be Left Alt, Right Alt or 
either of the Alt keys. Choose the "Third symbol key" command from the Options 
menu to customize this setting. See Customizing the Third Symbol Key for details.



Selecting the Physical Keyboard
In most cases, this operation is unnecessary, because 3-D Keyboard automatically 
identifies the type of keyboard attached to your computer (e.g., the IBM XT or AT 
keyboard, the IBM PS/2 keyboard, etc.). Should you suspect that your keyboard has 
not been identified correctly, choose the "Physical keyboard" command from the 
Options menu and click the model that matches your keyboard. Be careful not to 
misuse this command, or the layout displayed in the 3-D Keyboard window will not 
match your physical keyboard.

If you try to select another physical keyboard, and find that the menu option you 
desire is disabled (i.e. shown in gray rather than black), you should run Windows 
Setup and make sure that Windows itself has the correct information about your 
keyboard.

The physical keyboard selection is recorded in the initialization file, 3DKBD.INI. If the
initialization file is deleted, all settings are returned to their defaults.



Keyboard Menu
Note: To see more information about an underlined topic, click it or press Tab to 
highlight it and then press Enter. If the topic is underlined with a dotted line, hold 
the button down while you read.

Keyboard Layouts
Use these commands to select a keyboard layout.

The key combinations shown next to the layout names are the currently enabled 
hot keys. If a layout is shown without a hot key combination, there is currently no
hot key for this layout. Hot keys may be enabled, disabled, and customized by 
choosing the "Hot keys..." command from the Options menu. See Customizing 
the Hot Keys for details.

Pressing a hot key is a convenient alternative to using this menu, especially 
when the 3-D Keyboard window is minimized or hidden by other windows. The 
hot keys work only in Windows applications. They cease to be active after you 
exit or close 3-D Keyboard.

If several layouts have the same hot key assigned to them, pressing this hot key 
repeatedly will cycle through these layouts.

Exit
Use this command when you no longer need the additional keyboard layouts 
provided by the "3rd dimension" of the program. When you exit 3-D Keyboard, 
the default U.S. keyboard layout is automatically selected.

If you do want to use the additional layouts, but do not want to see the 3-D 
Keyboard window on your screen, minimize the window by clicking the down 
arrow in the top right corner. The 3-D Keyboard icon will appear at the bottom of 
your screen. This icon will indicate your currently selected keyboard layout and 
the availability of the symbols typed after a dead key.

The "Exit" command on this menu is equivalent to the "Close" command on the 
Control menu (also called System menu). The Control menu is activated by 
clicking an icon, typing Alt+Space, or clicking the small box in the upper left 
corner of the window.



Options Menu
Note: To see more information about an underlined topic, click it or press Tab to 
highlight it and then press Enter. If the topic is underlined with a dotted line, hold 
the button down while you read.

Hot keys...
Use this command to enable, disable, or customize the hot keys. Hot keys are a 
convenient alternative to using the Keyboard menu for selecting keyboard 
layouts, especially when the 3-D Keyboard window is minimized or hidden by 
other windows.

Colors...
Use this command to customize the colors used in the 3-D Keyboard window.

Edit keyboard layout...
Use this command to assign letters and symbols to different keys in the currently
selected keyboard layout.

Third symbol key
Use this command to customize the Third symbol key.

Font size
Use this command to change the size of the letters and symbols that are used to
mark key caps in the 3-D Keyboard window.

Physical keyboard
Use this command to tell 3-D Keyboard what type of keyboard is attached to 
your computer. In most cases this should not be necessary, because the program
normally detects this information automatically.



Help Menu

Index
This command displays a list of topics in the Help system, organized by subject.

Keyboard
This command displays instructions on the general use of the keyboard in 
Windows.

Using help
This command displays instructions for using the Help system. These 
instructions are part of Microsoft Windows.

About...
This command displays the 3-D Keyboard version number, copyright notice, and 
the address and telephone number of the publisher.



Customizing the Hot Keys
The key combinations shown next to the layout names on the Keyboard menu are 
called hot keys. Pressing a hot key is the easiest way to select a keyboard layout; 
you can do this even when the 3-D Keyboard window is minimized or hidden by 
other windows. These hot keys work only in Windows applications.

Hot keys may be customized by choosing the "Hot keys..." command from the 
Options menu.

You may wish to customize the hot key settings if:
- you want to set up hot keys that are mnemonic for you
- you want to assign one hot key to several layouts; then you can cycle through 
these layouts by repeatedly pressing this one hot key
- your current hot key combinations are used in your applications for other 
purposes (e.g., Ctrl+U may be used for the "Underline" command, in which case 
you would not want Ctrl+U as a hot key)

To customize a hot key setting:
- choose the "Hot keys..." command from the Options menu
- click the down arrow in the box next to the layout of interest
- scroll through the list of available key combinations and select the one that you

like best
- repeat this for all layouts that you want to use
- select None for any layouts that you do not plan to use
- click the OK button (or click Cancel to cancel all your changes)

When you click the word None instead of a key combination, the layout will have no 
hot key assigned to it. It may still be selected from the Keyboard menu. Remember 
that the key combinations assigned as hot keys in 3-D Keyboard are not available as
shortcuts in other applications. By selecting None for some layouts you maximize 
the number of available shortcuts.

If you click the Default button, all hot keys will be returned to their default settings.

The customized settings are recorded in the initialization file, 3DKBD.INI. If the 
initialization file is deleted, all settings are returned to their defaults.



Customizing the Colors
The 3-D Keyboard window uses three different colors on the key caps for:

- symbols typed by a key alone and by a key with Shift held down
- the symbol typed by a key with the Third symbol key held down; the same color
marks the Third symbol key
- dead keys

On monochrome screens, shading and highlighting may be used in place of colors.

To change the current color or shading scheme, choose the "Colors" command from 
the Options menu, then click the colors you want to try.

If you click the Default button, the colors will be set as when 3-D Keyboard was 
shipped by the publisher.

The customized settings are recorded in the initialization file, 3DKBD.INI. If the 
initialization file is deleted, all settings are returned to their defaults.



Editing the Keyboard Layout
The keyboard layouts used in 3-D Keyboard are based on the standards for personal
computers as described in DOS manuals. If you want to move some of the letters 
and symbols to different keys, select the layout that you want to customize, then 
choose the "Edit keyboard layout" command from the Options menu.

When the Edit Keyboard Layout dialog box opens, you can use the keyboard, the 
mouse, or both for selecting letters and symbols from the character chart and 
assigning them to keys.

Keyboard Only
Press the Tab key until the character chart is active: you will see a double border 
around it. Press the arrow keys to highlight the desired character. Press the key 
you want to use when typing this character. To assign the highlighted character 
to a shifted key, press the key while holding down Shift. To assign it as the third 
symbol on a key, press the key while holding down the Third symbol key.

Keyboard and Mouse
Move the mouse pointer over the character chart. Click the character that you 
want to move to a different key. Press the key you want to use when typing this 
character. To assign the highlighted character to a shifted key, press the key 
while holding down Shift. To assign it as the third symbol on a key, press the key 
while holding down the Third symbol key.

Mouse Only
Move the mouse pointer over the character that you want to assign to a different
key. Press and hold the left mouse button. Drag the mouse pointer over the key 
you want to use when typing the selected character. Note that the mouse pointer
changes shape and that the highlight on the key cap indicates whether the key 
will be pressed by itself, with Shift, or with the Third symbol key when typing the 
new character. Release the button.

Check the customized key in the 3-D Keyboard window: the symbol on the key cap 
should immediately reflect your change. Repeat these steps for each key you want 
to customize, then choose the OK button to finalize your changes. If you want to 
edit another keyboard layout, select it and repeat these steps. If you close the Edit 
Keyboard Layout dialog box by using its Control menu, your changes will be 
cancelled.

Use the Undo button to cancel your latest change. Use the Cancel button to cancel 
all changes made since you opened the Edit Keyboard Layout dialog box. The 
Default button will be enabled if you have made any changes to the default key 
assignments for this layout. Use this button to return all key assignments to their 
defaults. Use the Help button to display this text.

The third symbols may be erased from keys by using the eraser in the bottom right 
corner of the character chart. Choose the eraser, then drop it onto the key or press 
the key while holding down the Third symbol key.

If you assign the same dead key symbol to two or more keys, only one of these keys



will be "dead." The other key(s) will simply type the diacritic.

Letters with diacritics (normally available after a dead key is pressed) are assigned 
automatically when you assign the corresponding letters without diacritics. A letter 
with a diacritic may also be assigned directly to any key. You may wish to do this if 
for some reason you want to avoid using dead keys.

Notes on the Character Chart
Some symbols in the chart look like a thick vertical bar. These character positions 
are not used in Windows 3.0. If they are used in later versions of Windows, they will 
also be used in later versions of 3-D Keyboard.

The first character in the fifth row is the so-called non-breakable space. It is used by
some programs to indicate a space between words that should not be split across 
lines.

The fourteenth character in the fifth row is the so-called soft hyphen. It is used by 
some programs to indicate a hyphen that should be displayed and printed only if 
the word is split between two lines at this point. Other programs may use it for 
different purposes, e.g. to display a non-breakable hyphen.

Warning
To finish editing the current keyboard layout, you must close the Edit Keyboard 
Layout dialog box. This is done by choosing the OK or the Cancel button, or by using
the Control menu (also called the System menu). If you close this dialog box by 
choosing Cancel or by using its Control menu, your changes will be cancelled. While 
it is possible to switch to another program without closing the dialog box, 3-D 
Keyboard will not translate keystrokes until the Edit Keyboard Layout box is closed.

The changes made in the keyboard layouts are recorded in the initialization file, 
3DKBD.INI. If the initialization file is deleted, all settings are returned to their 
defaults.



Customizing the Third Symbol Key
Depending on the type of keyboard attached to your computer, you may designate 
either one or both of the Alt keys for typing the third symbol assigned to some keys.
The current Third symbol key is marked with a colored rectangle in the 3-D 
Keyboard window. If your physical keyboard has only one Alt key, you cannot 
customize the Third symbol key setting.

To customize this setting, choose the "Third symbol key" command from the Options
menu, then choose Left Alt, Right Alt, or Either Alt.

One reason to customize the Third symbol key is to avoid certain conflicts in the 
following functions of the Alt keys:

Activating the Menu Bar
In Microsoft Windows, pressing and releasing an Alt key activates the menu bar 
in the current window. This function is still available when the Either Alt option is 
selected. When only one of the two Alt keys is set to be the Third symbol key, 
this Alt key does not activate the menu bar.

Using Alt+Function Key
Some programs use combinations of Alt and function keys as shortcuts, e.g. 
Alt+F4 for the "Exit" command in Microsoft Word for Windows. This function is 
still available when the Either Alt option is selected. If only one of the two Alt 
keys is set to be the Third symbol key, this Alt key cannot be used for such 
shortcuts.

Using Other Shortcuts with Alt
Some programs use the Alt key in menus and dialog boxes: pressing Alt with an 
alphanumeric key selects an option. This function is still available when the 
Either Alt option is selected, but only for alphanumeric keys which do not have a 
third symbol on them. If only one of the two Alt keys is set to be the Third symbol
key, this Alt key cannot be used for such shortcuts.

The customized setting is recorded in the initialization file, 3DKBD.INI. If the 
initialization file is deleted, all settings are returned to their defaults.



Selecting the Font Size
The characters that are used to mark key caps in the 3-D Keyboard window may 
seem too large or too small on your screen. To change their size, choose the "Font 
size" command from the Options menu, then choose the desired size.

The new font size is recorded in the initialization file, 3DKBD.INI. If the initialization 
file is deleted, all settings are returned to their defaults.



The 3-D Keyboard Icon
If you do not want to see the 3-D Keyboard window with the current keyboard 
layout, you may shrink it to an icon by clicking the down arrow button in the top 
right corner of the window or by choosing the "Minimize" command from the Control
menu (also called System menu). The Control menu is activated by typing 
Alt+Space or by clicking the box in the top left corner of the window.

The appearance of the 3-D Keyboard icon changes to indicate the currently selected
layout or the recently pressed dead key.

Customizing the colors used by 3-D Keyboard does not change the colors used in its
icon.



Files Used by 3-D Keyboard
The four distribution files described below must be located in the same directory; 
the installation program for 3-D Keyboard places these files in the directory that you
specify. The INI file, also described below, is not distributed by the publisher; it is 
created in the Windows directory when you make a change in the default settings of
3-D Keyboard.

3DKBD.EXE is the executable program file. Its name, together with the directory 
name, should be used when creating a Program Manager item for 3-D Keyboard. 
The installation program for 3-D Keyboard normally does this for you.

3DKBD.DLL is an auxiliary file that is required for operation of the program.

3DKANSI.FON contains the 3-D Key Caps screen fonts. You should not use these 
fonts in your documents, because they have a very limited range of point sizes and 
were not designed for printing text.

3DKBD.HLP contains the help system for the program.

3DKBD.INI is the initialization file that is read by 3-D Keyboard when the program 
starts. This file is created in your Windows directory, and updated as you customize 
various options of the program. The format of this file is described in The 
initialization file. If this file is deleted, all settings are returned to their default 
values.



The Initialization File
The initialization file, 3DKBD.INI, is located in the Windows directory. This file is 
created the first time you make a change in one of the original settings, such as a 
hot key setting, the color scheme, etc. After that, a corresponding section in this file 
is updated every time you change a setting.

If the initialization file is deleted, all settings are returned to their defaults.

You should not need to edit this file; all settings are recorded automatically by 3-D 
Keyboard as you make changes via the Options menu. The file format is explained 
below for those who like to know such things.

The following is an example of the entire contents of an initialization file:

[Hot Keys]
EnhancedUS=48
France=112
Germany=189
Italy=191
LatinAmerica=0
US=65

[Colors]
NormalCharacter=128 0 0
ThirdSymbol=0 128 0
DeadKey=255 255 0

[Settings]
SymbolKey=3
PhysicalKeyboard=4
FontSize=1

[Keyboard Layouts]
France=&é"'(-è_çà)=q...p!^$as...lmù<*wxcvbn,;:!!123... etc. (only part of this line is
shown; ellipses indicate the omitted parts)
; The line above is the last line of John's 3DKBD.INI file.

The [Hot Keys] Section
The names of those layouts whose hot keys have been customized are listed 
here. All spaces and punctuation are removed from the layout names. The 
numbers to the right of the equal sign are the virtual key codes used by Windows
programmers; they are published in Microsoft technical reference manuals. For 
letters and digits these are the same as ASCII numbers.

The [Colors] Section
The names are the same as on the Colors dialog box in 3-D Keyboard, with 
spaces and punctuation removed. The numbers are the decimal values for the 
red, green, and blue components, in that order. These values must be between 0
and 255. The following combination, for example, defines pure red: 255 0 0. 
Windows Paintbrush shows these numbers as you use the "Edit Colors" 



command on its Options menu.

The [Settings] Section
SymbolKey defines the setting for the Third symbol key.
PhysicalKeyboard defines the setting for the Physical keyboard.
FontSize defines the setting for the size of the characters that are used to mark 
key caps in the 3-D Keyboard window.

The numbers stand for the options shown on the respective menus, the top 
choice being 1.

The [Keyboard Layouts] Section
The names for the layouts are the same as in the Hot Keys section. The 
characters to the right of the equal sign show the current key assignments; they 
roughly follow the order of the keys on the keyboard; more precisely, they follow 
the order of scan codes. An exclamation point precedes every dead key. An 
exclamation point that does not mark a dead key is shown twice. We do not 
recommend editing this section of the initialization file; any key assignments 
may be done with more precision and ease by using the "Edit keyboard layout" 
command.

A semicolon may be used to introduce a comment line; all text on a line that begins 
with a semicolon is ignored by 3-D Keyboard.



Control Panel and 3-D Keyboard
Control Panel is a program that is included with Microsoft Windows. It lets you 
change the configuration of your system, including the default keyboard layout. In 
order to use 3-D Keyboard, the default keyboard layout must be set to "US." If you 
think that your setting is different, choose the "International" command in Control 
Panel and reset the keyboard layout.

This requirement does not impair any flexibility of Windows, since 3-D Keyboard 
provides an easy way to switch between keyboard layouts.

The rest of the settings, e.g. the date and currency format, may be selected as 
desired. 



3-D Key Caps Font
While 3-D Keyboard is running, some applications may include the 3-D Key Caps 
(ANSI) font in the list of available fonts. This is the font that is used in the 3-D 
Keyboard window. Avoid using this font in your documents, because it has a very 
limited range of point sizes and was not designed for printing text.



Windows Fonts and 3-D Keyboard
Most Windows applications use the ANSI character set in their fonts. This version of 
3-D Keyboard can be used with all ANSI fonts.

Most non-Windows programs for personal computers use the IBM PC extended 
character set. The authors of Microsoft Windows refer to this as the OEM character 
set. Windows 3.0 includes one OEM font called Terminal. Do not use this font with 3-
D Keyboard. When using the Windows Terminal program, select some other font 
from the Terminal Preferences options on the Settings menu.

In general, non-ANSI fonts, including the Windows Symbol font, cannot be used with 
this version of 3-D Keyboard.

Future versions of 3-D Keyboard may support non-ANSI fonts.

If future versions of Microsoft Windows use an expanded character set, future 
versions of 3-D Keyboard will also use this character set.



Non-Windows Programs and 3-D Keyboard
3-D Keyboard works only with programs written for Microsoft Windows version 3.0 
and later. When you temporarily leave Windows to work with a DOS program, or 
when you exit Windows, the standard U.S. keyboard layout takes effect, and the 
additional layouts cannot be used.



Glossary
Choosing
Switching
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Customization
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Choosing a menu item issues a command to the program, e.g. Exit. This can be 
done with the mouse or with the keyboard.

Mouse
Move the pointer to the menu name and briefly press the left button to activate 
the menu, then move the pointer to the desired command and briefly press the 
left button again.

Keyboard
While holding down the Alt key, type the letter that is underlined in the menu 
name, then release both; now type the underlined letter in the desired 
command.



Switching to a window makes this window active. The other windows on your screen
become inactive. You can switch using the mouse or the keyboard. You can also use 
the Task List.

Mouse
Move the pointer to any part of the window and briefly press the left button.

Keyboard
Press Alt+Esc several times, cycling through all your running applications until 
the desired window is active.

Task List
Press Ctrl+Esc, move the mouse pointer or the highlight to the desired 
application name, and double-click or press Enter.



Clicking a menu, a button, or some other object on the screen activates this object 
or prepares it for your next action.

To click an object, move the mouse pointer to the object and briefly press the left 
button.



Double-clicking an object on the screen activates this object and starts some action.

To double-click an object, move the mouse pointer to the object and press the left 
button twice in rapid succession.



Shortcut key combinations are keyboard alternatives to using menus. For example, 
in Microsoft Word for Windows, pressing F4 while holding down the Alt key is 
equivalent to choosing the "Exit" command from the File menu. Shortcuts are 
specific to applications and can be used only when the application window is active.

A shortcut key combination, if it exists, is shown on the menu next to the command.
The notation Alt+F4, for example, means "press F4 while holding down Alt." The 
letter in the shortcut notation is the one that is printed on the key cap of your 
physical keyboard, not the one that may be assigned to the key in a particular 
keyboard layout.



Hot key combinations are a convenient alternative to using the Keyboard menu for 
layout selection. Hot keys work even when the 3-D Keyboard window is minimized 
or hidden by other windows. When you use a hot key, you do not have to leave your
application window (e.g. your word processor) in order to select a different keyboard
layout.

Hot key settings may be customized by choosing the "Hot keys..." command from 
the Options menu. See Customizing the Hot Keys for details.

The current hot key combinations are shown on the Keyboard menu next to the 
names of the layouts. The notation Ctrl+U, for example, means "press U while 
holding down Ctrl."

The letter in the hot key notation is the one that is printed on the key cap of your 
physical keyboard, not the one that may be assigned to the key in a particular 
keyboard layout. 

When the same hot key is assigned to several layouts, pressing this hot key 
repeatedly will cycle through these layouts.

The key combination assigned to a layout as its hot key is not available as a 
shortcut in any application. For example, if Ctrl+U is the hot key for the U.S. 
keyboard layout, you cannot use this key combination as a shortcut for the 
"Underline" command in your word processor. You will have to use a menu or a 
button for the "Underline" command. Alternatively, you may set the hot key for the 
U.S. layout to a different key combination.

Hot keys cease to be active when you switch to a non-Windows application or exit 3-
D Keyboard.



Dead keys, when pressed, do not type any letters or symbols. Their purpose is to 
make additional letters available, typically letters with diacritics. The letter with the 
diacritic will be typed when its key is pressed after the dead key. For example, to 
type a German A diaeresis with the Enhanced U.S. keyboard, press the Umlaut dead
key and then A.



Diacritics are marks added to letters in order to distinguish them from other letters 
of similar form, e.g. the tilde over the letter n in Spanish. In most keyboard layouts, 
letters with diacritics are typed using the dead key method.



Customization in this text does not refer to any irreversible changes in 3-D 
Keyboard. All changes made through the menus of this program may be cancelled 
at any time by any user. These changes are recorded in the initialization file, 
3DKBD.INI. If the initialization file is deleted, all changes are cancelled.



ANSI vs. OEM Character Sets
Most Windows fonts use the so called ANSI character set. ANSI stands for American 
National Standards Institute. Most non-Windows programs for personal computers 
use the so called IBM PC extended character set, which the authors of Microsoft 
Windows refer to as the OEM character set. Windows 3.0 includes one OEM font 
called Terminal.



Why Some Shortcuts Do Not Work
The key combination assigned to a layout as its hot key is not available as a 
shortcut in any application. For example, if Ctrl+U is the hot key for the U.S. 
keyboard layout, you cannot use this key combination as a shortcut for the 
"Underline" command in your word processor. You will have to use a menu or a 
button for the "Underline" command. Alternatively, you may set the hot key for the 
U.S. layout to a different key combination.

Hot key settings may be customized by choosing the "Hot keys..." command from 
the Options menu.



Limitations of This Version
This version of 3-D Keyboard:

- includes keyboard layouts only for those languages that are supported by the 
Windows 3.0 ANSI fonts; it does not work with the Symbol font or the Terminal
font, but it does work with the Terminal program when an ANSI font is 
selected

- cannot be used with versions earlier than 1.80 of the network communication 
program Da Vinci eMAIL

- may be incompatible with some screen saving programs that use the keyboard 
in unconventional ways; when setting the password in the screen saving 
program After Dark, always use the standard U.S. keyboard layout, and 
before typing the password, press Caps Lock so that you type in upper case

If you use the macro Recorder that is part of Microsoft Windows, do not assign your macros 
to Alt key combinations because they are not played back correctly while 3-D Keyboard is 
running. Use Shift and/or Ctrl key combinations instead.

3-D Keyboard does not translate keystrokes properly when used with the Microsoft 
Windows Calculator.



Future and Related Products
Future versions of 3-D Keyboard will support more languages and eliminate other 
limitations of this version.

If future versions of Microsoft Windows use an expanded character set, future 
versions of 3-D Keyboard will also use this character set.

Russian and all modern Slavic languages are supported by a package called Cyrillic 
Support, available from the publisher of 3-D Keyboard. In addition to a keyboard 
program similar to 3-D Keyboard, this package includes Cyrillic-and-Latin screen 
fonts and matching fonts for dot-matrix and laser printers.

Other laser printer fonts are also available from the publisher of 3-D Keyboard.



Sending Suggestions for Improvement
The creators of 3-D Keyboard, Peter Cassetta and Slava Paperno, may be reached 
c/o Exceller Software Corp., 223 Langmuir Lab, Ithaca NY 14850 or c/o Department 
of Modern Languages and Linguistics, Cornell University, Ithaca, NY 14853. Several 
other computer programs for teachers and students of foreign languages have been
written at the Department by this team and by other linguists.



Publisher
Exceller Software Corp., 223 Langmuir Lab, Ithaca, NY 14850, tel. (607) 257-5634, 
fax (607) 257-1665.



License Agreement

Grant of license. Under this license you may:

a) use 3-D Keyboard (the "software") on only one machine at a time, unless an 
agreement with Exceller Software Corporation ("Exceller") specifies otherwise

b) copy the software for backup
c) transfer possession of the software to another party.

Copyright. The software is licensed to you by Exceller and is protected by United 
States copyright laws and international treaty provisions. Therefore, you must treat 
the software like any other copyrighted material.

Restrictions. You may not rent or lease the software, but you may transfer the 
software on a permanent basis provided you retain no copies, and the recipient 
agrees to the terms of this Agreement. You may not reverse engineer, decompile, or
disassemble the software. If the software is an update, any transfer must include 
the update and all prior versions.

Limited warranty. Exceller warrants that the software will perform substantially in 
accordance with the accompanying on-line documentation in this Help system for a 
period of 90 days from the date of receipt. Any implied warranties on the software 
are limited to 90 days. Some states do not allow limitations on duration of an 
implied warranty, so the above limitation may not apply to you.

Customer remedies. Exceller's entire liability and your exclusive remedy shall be, at 
Exceller's option, either a) return of the price paid or b) repair or replacement of the 
software that does not meet Exceller's Limited Warranty and which is returned to 
Exceller with a copy of your receipt. This Limited Warranty is void if failure of the 
software has resulted from accident, abuse, or misapplication. Any replacement 
software will be warranted for the remainder of the original warranty period or 30 
days, whichever is longer. These remedies are not available outside of the United 
States of America.

No other warranties. Exceller disclaims all other warranties, either express or 
implied, including but not limited to implied warranties of merchantability and 
fitness for a particular purpose, with respect to the software and the accompanying 
on-line documentation in this Help system. This limited warranty gives you specific 
legal rights. You may have other rights which vary from state to state.

No liability for consequential damages. In no event shall Exceller or its suppliers be 
liable for any damages whatsoever (including, without limitation, damages for loss 
of business profit, business interruption, loss of business information, or other 
pecuniary loss) arising out of the use or of inability to use this product even if 
Exceller has been advised of the possibility of such damages. Because some states 
do not allow the exclusion of limitation of liability or consequential or incidental 
damages, the above limitation may not apply to you.

This agreement is governed by the laws of New York State.



Exceller Software Corporation, 223 Langmuir Lab, Ithaca, N.Y. 14850 1-(607) 257-
5634.



Windows Keys
This general information about the use of the keyboard in Windows was prepared by 
Microsoft. Some of the sections may be easier to read if you enlarge the Help window
Cursor movement keys
Dialog box keys
Help keys
Menu keys
System keys
Window manipulation keys



Cursor movement keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog box keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Help keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



 



Window manipulation keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.


